
Chapter 6  Restoring Data

Overview

This chapter describes how to:

• Restore selected files and directories
• Restore sessions from media
• Restore an entire resource
• Restore an older version of a database
• Restore data to another location
• Restore a server
• Recover the installation volume
• Clone a server
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Introduction

Recovering data with Backup Director is easy because of its File History and System Control
Databases. Using the databases, the program automatically prompts you for  the backup
media that will result in the most efficient restore process.

You  can  restore  an  entire  volume,  including  the  directory  structure,  data,  and  history
database of a selected resource in Resource Manager, and selected directories and files on a
resource  in  File  Manager.   Additionally,  you can search for  files  on mounted media and
restore them to disk using Media Manager. 

Monitoring Restore Jobs

If you view the progress of a restore job through the Restore Job Status window, you will be
able to see how many of the items remain to be restored. 

The  window  displays  information  about  the  number  of  items  specified  for  the  restore
operation (Scheduled Items parameter) and the number files that have yet to be restored
(Remaining Items parameter)

Redirecting a Resource's Data 

In some recovery situations, a volume may be off-line, requiring you to redirect data from
that volume to another on-line volume. 

The Redirect to option in the Restore Options dialog box allows you to redirect data (or an
entire volume) to another volume.

To redirect data from one volume to another, select Restore/Data and choose Redirect to.
All data (including directories) is redirected from the current volume to the target volume
you choose. Use this procedure when a volume is going to be down temporarily, but you
want access to the data on that volume.

To  redirect  an  entire  volume,  including  the  volume's  File  History  Database,  to  another
volume, select Restore/All and choose Redirect to. When redirecting a full volume, you are
basically “cloning” the source volume.

Generally, you would only use this procedure if you were replacing one volume with another
volume and removing the original volume from the Protected Resource List.

NOTE: If  you  plan  on  a  full  or  partial  restore  of  a  volume to  a  different
server (for example, from NetWare 3.11 or 3.12), you must recreate directory
and file trustees for users not on the target server.

Restoring Directories and Files 

This section details procedures for restoring the most current version of files to their original
or new location. If you want to restore an older version, proceed to the “Restoring an Older
Version of a File” section.

NOTE: If you want to restore directories and files from one server to another,



you must first create the trustees and Object IDs on the target server for users
that are not already defined there.

To restore directories or files 

1. In File Manager, select the volume containing the files you want to restore using the
File/Open Resource menu option.

TIP: If you are unsure where the file is located within a particular volume,
you  can  use  the  View  menu's  Define  File  Filter option  or  the  Operations
menu's File Finder option to locate the file. 

2. Tag the directories and files you want to restore.

3. Open the Operations menu and select Restore.

4. Select  the  type  of  restore  you want  to  perform.  The  Restore  Options  dialog  box
appears.

> To  restore  the  tagged  file(s)  to  their  original  location,  select
Restore/Original. 

> To  restore  only  the  tagged  file(s)  to  a  different  location,  select
Restore/Redirected.   The  SMS  Target  dialog  box  appears.  Choose  the
Resources button  to  select  the  server,  TSA,  target  service,  and resource
associated  with  the  new location.  Choose  the  Path button  to  specify  the
target directory path and its name space.

¾To also redirect the directories of the files, turn on the
Retain Directory Structure option.

5. Sometimes the files scheduled for a restore operation already exist on the disk. Set
the  Overwrite parameter to specify when the program should overwrite the disk
copy with the media copy.

> To overwrite the disk file with the media version, select Always.

> To preserve the file on disk, select Never.

> To overwrite the disk copy only if it is older than the copy on media,
select Older.

> To receive a prompt when the program finds a file already on disk,
select  Prompt.  If  you  submit  a  restore  job  in  unattended mode with  this
parameter set to  Prompt, the program will not restore any file that already
exists  on  disk.  As  a  result.  Backup  Director  will  record  a  message  in  the
System Message database indicating that it did not restore the file.

6. Select any other job parameters.

7. Choose OK to submit the restore job to the job queue.

8. You may have to load media. If Backup Director cannot find any media or it needs
additional media to complete the restore operation, it will prompt you for media. This
provides the most automated restore behavior.



9. If Backup Director finds that no eligible media are mounted, a System Message dialog
box appears. This dialog box provides a choice of options. 

10. Select the  Display list of suggested media option (choose Defer if you want to
deal with the restore job at a later time). The Media Pick List dialog box appears.

The following information is provided on the screen: 

Parameter
Description

Media Displays the media label.

Status Displays the media that Backup Director determines is
best for the operation (resource-level restore operations only). 

Preferred media is the media with
the greatest number of unique files scheduled for
the  restore  operation.  There  can  be  multiple
preferred  media.  Eligible  media  are  all  other
media that  have at  least  one of  the  scheduled
files.

Files Number  of  the  scheduled  files  that  are  on  a  specific
media (file-level restore operations only).

Unique Number of scheduled files which exist only on one media
(file-level restore operations only).

Type The type of media (optical disk,, 8 mm tape,, etc.) the
data is located on.

Location The device or slot the media is located in (if any).

11. Load the media. Highlight the media and choose OK. If you turned on a device after
the Media Pick List dialog box appeared, select the Scan button to refresh the list of
media and devices. 

> If you are using an autoloader with an import/export door, you may
need to choose the Import button to load the media in the door. When you
close the door, the device loads the media into the first available slot. Choose
Scan to refresh the choices on the Media Pick List. Highlight the media and
choose OK. When the program has restored all of the files from a media, the
media no longer appears in the Media Pick List.

As media are used, subsequent pop-up windows indicate the correct number of files that still
need to be restored.

In addition, the program automatically deletes a media from the list if it contains only those
files which have already been restored from a previous media. As a result, the Media Pick
List shows only those media containing files which have not yet been restored.

12. Continue to insert media until all of the files have been restored.



Restoring an Older Version of a File 

Restoring an older version of a file is a common request in most LAN environments. Backup
Director's use of the File History Database allows administrators, operators, and end users to
restore an older version of a file from that file's history quickly and easily. The database
maintains the history of every item that exists in the File History Database.

In order to restore an older version of a file, you must tag the desired version of the file in
the history window.

TIP: To quickly restore a single file version, you can select the file version
from  the  Extended  History  window  and  choose  the  Restore button.  The
program restores the file to the original location.

To restore older versions

1. Highlight the file that you want to restore. The history window displays any available
file versions for that file. 

2. Tag the file version you want to restore. You cannot restore multiple file versions of
the same file to the same location because each subsequent version will overwrite
the previous one.

3. Open  the  Operations  menu  and  select  Restore.  The  Restore  Options  dialog  box
appears.

4. Select the location where you want to restore the file.

5. Specify the Overwrite parameter you want Backup Director to apply if it finds that
any of the files scheduled to be restored already exist on the disk.

6. Specify any other job parameters.

7. Choose OK to submit the restore job to the job queue.

8. Insert  the  media  requested  by  Backup  Director  until  all  of  the  files  have  been
restored.

Restoring Files in Media Manager

Restoring from Mounted Media

If a file copy is not tracked in the File History Database, you must use Media Manager to
select the file copy directly from mounted media and perform the restore operation. Some
reasons why file versions are not recorded in the File History Database:

• The  user  did  not  choose  to  track  this  session  in  the  File  History
Database when creating the job.
• The file was written to non-managed media by a pre-4.0 Palindrome
product and could not be tracked in the File History Database.
• The media has been forgotten.
• The  file  was  written  by  another  SMS-compliant  application  and



therefore, Backup Director has no knowledge of these files. 

In each of these cases, the only way to restore (or copy)
a file from media to disk is to display the contents of the media
(also  called  “journaling”).  Then,  search  for  the  sessions
containing the files you want. 

To restore a file using the session journal

1. Mount the media in the device.

2. From Media Manager, open the View menu and select Mounted Media. The Mounted
Media window appears.

3. Highlight the mounted media you want to journal.

4. Choose the  Journal button.  Do not close the job status window or Media Manager
while  the  journal  job  is  running;  you will  abort  the  job.  The Session  List  window
appears.

5. Select  the  appropriate  button  depending on  the  kind  of  restore  job  you want  to
create.

> To  restore  an  entire  session,  highlight  a  session  and  choose  the
Restore button. The Restore Options dialog box appears.  “CP” indicates a
backup session. File History Database sessions are labeled “DH” and System
Control Database sessions are labeled “DC.” 

> To restore selected directories or files, highlight a session and choose
the  View button. The media session window appears. The file window lists
files located under the highlighted directory. 

6. If you choose the  View button, the program begins building the directory and file
windows. This  can take some time, depending on the size and complexity of  the
directory structure. The program allows you to pause from building after it completes
a directory. You can view the file window or perform an activity elsewhere while the
program is building the directory structure.

> To interrupt the building process, choose the  Pause button after the
program builds the directory you want to see. Choose the Resume button to
let the program resume building directories. 

In the media session window, the volume appears at the top of the tree, followed by a list of
directories. The file information includes the date and time stamp, attributes, and byte size
of each file. 

You can collapse and expand directories. When you highlight a directory, the files residing on
the directory appear in the file window on the right side of the window. 

7. Tag the directories or files you want to restore.

8. Open the Operations menu and select Restore.

9. Select the type of restore operation. The Restore Options dialog box appears.



10. Specify the location where you want to restore the file(s). 

11. Specify the type of Overwrite parameter.

12. Select any other job parameters.

13. Choose OK to submit the restore job to the job queue.

14. You  can  continue  to  journal  the  session  and  tag  items  for  additional  restore
operations.  Periodically,  the  program  prompts  you  to  indicate  whether  you  are
finished journaling the media. Choose  Yes to end journaling and exit the mounted
media's session window. The program will not attempt to process the restore jobs
until you have completed journaling.

Restoring Tracked Files in Media Manager

Occasionally you may want to identify the files copies that reside on a particular tracked
session.  Media  Manager  provides  a  database  session  window which  provides  the  same
restore features as File Manager's directory and file windows. 

If you know which tracked directories and files you want to restore, you can restore them
more quickly through File Manager. If you want to view the files and directories located on a
particular session, it is quicker to view the contents of the session through the Mounted
Media window than build the database session window. If the media is not available and the
session is tracked, you can still restore from the database session window.

To restore tracked file copies in Media Manager

1. From Media Manager, highlight a session.

2. Open the View menu and select  Session Window. The program begins building the
database session window.   This  can take some time,  depending on the  size  and
complexity of the directory structure. The program allows you to pause from building
this window. 

3. Tag the directories and files you want to restore.

> If you must search for specific files, open the Operations menu and
select File Finder.

4. Open the Operations menu and select Restore.

5. Select the type of restore operation. The Restore Options dialog box appears.

6. Specify the location where you want to restore the file(s).

7. Specify the type of Overwrite parameter.

8. Specify any other job parameters.

9. Choose OK to submit the restore job to the job queue.

Data from Non-SMS Versions



To restore a File History Database from non-SMS media, you must restore the appropriate
*.PAC files through the Session List window. When restoring data from media written with
non-SMS versions of Backup Director, all file data and attributes, and directories and their
attributes are restored. CRCs (Cyclical Redundancy Codes) are also valid. 

The following objects cannot be restored, however:  trustees, volume restrictions, directory
restrictions, owners, Bindery files, System Control Databases, and File History Databases. 

Restoring Machines and/or Resources

To restore a machine and/or resource

1. From Resource Manager, tag the machine or resource you want to restore.

2. Open the Operations menu, and select Restore. The Restore menu appears.

3. Select Full Resource. For more information on this option, see the “Restore Options”
section below.

4. Specify the location where you want to restore the resource.

5. Select any other job parameters.

6. Choose OK to submit the restore job to the job queue. 

7. Load the media as requested to restore all directory, file, and trustee information that
existed on the machine or resource the last time you backed it up.

A complete volume recovery may take some time depending on the amount of data to be
restored. See chapter 6 for information about restoring a volume's data to another volume.

Restoring an Older Version of a Database

If you need to restore a version that is older than the most current version on media, you
must select the version from the physical journal rather than through the database. 

To restore an older version of the File History Database

1. Load the media you want to journal.

2. From Media Manager, open the View menu and select Mounted Media. The Mounted
Media window appears. 

3. Highlight the media you want to journal.

4. Choose the Journal button. Do not close the job window or Media Manager while the
journal job is running; you will abort the job. The Session List window appears. This
window displays the date, size, and number of files contained on each session. 

5. Highlight the database session you want to restore. File History Database session you
want to restore. File History Database sessions are labeled “DH” and System Control
Database sessions are labeled “DC.” 



6. Choose the Restore button. The Restore Options dialog box appears.

7. Specify the restore parameters.

8. Choose OK.

9. Choose  Yes to end journaling and exit the mounted media's session window. The
program  will  not  attempt  to  process  the  restore  jobs  until  you  have  completed
journaling.

Restore Options

This  section details  the  options  available  through Resource  Manager for  restoring entire
resources or resource i formation. The Restore operation has four available options:

Full Resource(s) 

The  Full  Resource(s)  option  recovers  all  of  the  information  for  the  tagged  resource(s),
including  the  File  History  Database(s),  directories,  trustees,  files,  and  volume/disk  and
directory restrictions. Selecting this operation overwrites any existing information.

Typical use: This operation should be used if a complete server or volume was lost since it
will restore all of the information for a selected volume.

File History Database(s) 

The File History Database(s) option restores a resource's File History Database from media,
overwriting the existing database. 

The program restores the most recent copy of  the database on media to its  configured
location. 

Typical use: Use this operation if a volume's File History Database has been deleted or
damaged  and,  therefore,  must  be  restored  from  media  (for  example,  the  File  History
Database files are corrupt).

Directory Structure(s)  

The  Directory Structure(s) option allows you to recover the directory tree for the selected
volume(s).  NetWare trustee rights and volume/disk and directory restrictions on NetWare
server volumes are also recovered. This option also restores empty directories. Depending
on  the  version  of  directory  structure  you  are  restoring,  this  type  of  restore  operation
overwrites trustees for existing users and may recreate user trustees that were not currently
configured prior to the restore. This operation does not restore user data, only the directory
structure, associated trustee rights, and volume/disk restrictions. 

Typical use:  This  operation can be a used to duplicate a directory  structure on a new
volume.  After you restore the directory structure, you typically use the Restore/Data option
to restore files. This operation can also be used to restore the most recent version of trustee
rights from media and is the only option available to restore empty directories. 

Data

The  Data  option recovers all user data for the selected volume(s), the directory structure,



and associated trustee rights. This option does not restore empty directories.

This does not include the NetWare Bindery files on SYS: volumes. Selecting this operation
overwrites existing files only if the file on media has a newer time stamp (i.e., if the disk file
is older than the file on media). NetWare Bindery files and NetWare Directory Services can
only be recovered by tagging the Bindery resource and then selecting Full Resource(s).

Typical  use:  This  option  should  be  preceded  by  the  Restore/  Directory  Structure(s)
operation (unless the volume's directory structure already exists).

Redirecting Volume Data 

The following provides instructions for redirecting data from one volume to another volume
on the Protected Resource List. This procedure is especially useful if a volume is down and
you want immediate access to its data.

Assumptions

• The
volume  you
are
redirecting
data  to  is  on
the  Protected
Resource List

• Your installation directory is not on a failed volume.

To redirect a volume to a new or existing volume

1. If the volume you are redirecting to is not one that is currently protected, add the
resource using Resource Manager. 

2. In Resource Manager, highlight your original source volume (the volume you want to
redirect data from) and tag it.

3. Select Operations/Restore.

> Select  Data  to redirect data without moving the source volume's File
History Database.

> Select Full Resource if you want to clone the volume (redirect data and
the source  volume's  File  History  Database to  the  target  volume).  The  File
History  Database  is  copied  to  the  target  volume's  File  History  Database
location.

4. On the restore options dialog box, select Redirect to.

5. Choose the Server, TSA, Target Service, and Resource to redirect data to and choose
OK.

If the server does not appear in the window, be sure you have loaded the correct TSA for
that server.

All information (including all directory, file, and trustee information) is restored from your



original volume to the target volume you have selected. 

If you selected  Full  Resource  as your restore option, the File History Database from your
original volume now belongs to the target volume.

Recovering an Installation Volume  

Backup Director relies on its databases, the Windows executables, and the engine NLM files
to run properly. If any of these components is missing, you will have to perform some type of
recovery operation either at the Windows workstation or at the server.

Recovering Databases and Executables

If a volume fails that contains the System Control Database (and/or the executables), you
can restore that volume using the Server Control Console on the installation server or from a
workstation (using SETUP.EXE on the installation diskettes).

Assumptions

• The failed volume is not a SYS: volume
• Your Backup Director NLMs are available.

NOTE: If  you need to recover a SYS: volume and/or Backup Director NLMs,
proceed to “Recovering a SYS: Volumes and NLMs” below.

To recover an installation volume using the server console

1. Insert  the  most  recently  used  media  in  your  backup  device  (the  System Control
Database is written to the media with every backup operation).

2. At the server console of your installation server, type:

LOAD PAL

The following screen appears.

3. At the Server Control Console, select Recover System Control Database.

4. Select the server volume and path of your System Control Database (AS*.PAC) files.

5. Type in your auto login user name and password in the appropriate fields. This must
be a valid user.

If  the Bindery or  NDS doesn't  exist  on your installation server at  this  point,  type
SUPERVISOR in the auto login name field for NetWare 3.x servers; type ADMIN in the
auto login name field for NetWare 4.x servers.

6. Select Start Recovery.

When the System Control Database is found on media, you are notified of the date of
the System Control Database on media. Be sure the date indicated represents the



last  backup  operation  performed;  if  it  does  not  insert  the  media  with  the  latest
backup session and retry the operation.

Once the System Control Database has been restored from media, the program will
have access to the Protected Resource List so you can begin restore operations. 

NOTE: If you typed in a name different than your auto login user, the program
asks if you want to use the name you typed in or the original auto login user
to continue the recovery. If you need to restore NDS or the Bindery, use the
current name (for example, ADMIN or SUPERVISOR). If not, use the original
auto login user name.

After  the  bindery  (or  NDS)  is  restored,  update  the
System Control Database with the original auto login user name
using  the  Update  Auto  Login  Information  option  on  the
Palindrome Server Console.

7. After the System Control Database is restored, at the Server Control Console, select
Backup or Restore Resources.

8. Tag the installation volume and select Restore. 

If you need to restore NDS or the Bindery, restore those resources first then restore
the SYS: volume (if necessary) and then the installation volume. 

9. Insert  the requested media as  prompted.  This  will  restore to  the new volume all
directory, file, and trustee information that existed on the failed volume at the last
backup. 

To recover an installation volume using the workstation

1. Insert Backup Director installation diskette #1 into your disk drive.

2. At a Windows workstation, access Windows.

3. Open the File menu and select Run. Type:

A:SETUP (where A: is the drive your diskette is in)

4. Specify  your  current  installation  directories  for  the  Windows executables  and the
database files. Be sure to specify the same directory as you originally installed them.
Choose OK. Files are copied to the directory(s) that you specified.

After  the  files  are  copied,  you  are  asked  if  you  are  performing  an  installation
(including an upgrade) or a recovery.  Select Recovery.

6. If the System Control Database needs to be recovered, Backup Director will prompt
you to configure a device to use for the recovery.

After the device is configured, Backup Director automatically submits a job to restore the
System Control Database and launches Control Console.

If for some reason, the job is not submitted to the job queue, load PAL at the server console
and select  Recover System Control Database. Specify the path of the installation directory
and the auto login user name and select Start Recovery.



7. Monitor the job using Control Console at the workstation and respond to prompts.

8. After  the  System Control  Database  is  restored,  open  Resource  Manager.  Tag  the
installation volume. Open the Operations menu and select Restore/Full Resource.

9. Insert  the requested media as  prompted.  This  will  restore to  the new volume all
directory, file, and trustee information that existed on the failed volume at the last
backup. 

Recovering a SYS: Volume and NLMs 

The procedure below outlines steps to recover a SYS: volume and Backup Director NLMs.
NLMs must be recovered using the installation diskettes.

Backup Director requires the following NLMs and resource files to perform restore operations
at  the  server:   PALREST.NLM,  PALMEDIA.NLM,  PAL.NLM,  PALALDRV.NLM,  PALSDRV.NLM,
PALLIB.NLM, PALJSRVR.NLM, ARNADAT.RSF, ARNANDX.RSF

These files are copied during installation to the SYS:\SYSTEM directory.

Depending on the type of recovery you need to perform, you may not need to perform all of
the steps listed below.

To recover a SYS: volume and Backup Director NLMs

1. Reinstall NetWare and mount the volume. 

2. To ensure you have the most recent NetWare modules, run SETUP.NLM on the server
(SETUP.NLM is found on the Backup Director server preparation diskette #1). See the
Installation Guide for more information on running SETUP.NLM.

3. If you ran SETUP.NLM, PALLOADR.NLM was copied to the SYS:\SYSTEM directory on
your server. At the server console prompt, type:

LOAD PALLOADR

4. At  a  workstation,  insert  the  Backup  Director  installation  diskette  #1  into  a
workstation drive.

5. Access Windows.

6. Open the File menu and select Run. Type:

A:SETUP

(where A: is the drive your diskette is in)

7. Specify  your  current  installation  directories  for  the  Windows executables  and the
database files. Be sure to specify the same directory as you originally installed them.
Choose OK. Files are copied to the directory(s) that you specified.

8. After  the  files  are  copied,  you  are  asked  if  you  are  performing  an  installation
(including an upgrade) or a recovery.



> If  your  System Control  Database  exists  (i.e.,  it  is  not  on  the  SYS:
volume you are recovering) select  Abort and continue to the section “Load
NLMs” below.

> If you need to recover the System Control Database, Select Recovery.

9. If the System Control Database needs to be recovered, Backup Director will prompt
you to configure a device to use for the recovery.

After the device is configured, Backup Director automatically submits a job to restore
the System Control Database and launches Control Console.

If for some reason, the job is not submitted to the job queue, load PAL at the server
console  and  select  Recover  System  Control  Database.  Specify  the  path  of  the
installation directory and the auto login user name and select Start Recovery.

10. Monitor the job using Control Console at the workstation and respond to prompts.

11. After the System Control  Database is restored, at the workstation, open Resource
Manager. 

12. Tag the SYS: volume. Open the Operations menu and select  Restore/Full Resource.
The SYS: volume will be restored to its most recent state.

NOTE:On 3.x servers,  restore the Bindery resource prior to recovering the
SYS: volume. 

On 4.x servers, you do not need to restore NDS unless your installation server
is the only server in your NDS tree.

Load NLMs

If you didn't need to recover the System Control Database when recovering the SYS: volume,
perform the following. The job server (PALJSRVR) and PALMEDIA must be loaded on your
installation server if they are not already loaded. 

1. To load the job server, at the server console prompt, type:

LOAD PALJSRVR /I<<installation path>>

where  <<installation  path>>  is  the  volume  and  directory  of  your  installation
directory (for example, VOL1:\PAL). 

2. After the job server is loaded, at the server console prompt, type:

LOAD PALMEDIA

3. At a workstation, open Resource Manager. Tag the SYS: volume in Resource Manager.
Open the Operations menu and select Restore/Full Resource. The SYS: volume will be
restored to its most recent state.

NOTE:On 3.x servers,  restore the Bindery resource prior to recovering the
SYS: volume.



On 4.x servers, you do not need to restore NDS unless your installation server
is the only server in your NDS tree.

Restoring a Server 

The following provides steps for replacing a server that has crashed. 

NOTE:To  prepare  for  disaster  recovery  such  as  a  complete  server  crash,
follow the instructions in Appendix C, “Disaster Recovery.”

If the server you are recovering contains the Backup Director installation volume, see the
instructions for recovering an installation volume below.
Assumptions

• Your new server has the same name, NetWare version,  and volume
names as the original server.
• You are replacing your original server on the Protected Resource List.
• The File History Databases for your original server are accessible.

1. Remove the original server from your network by downing it.

2. Generate a replacement server by installing the same version of NetWare as your
original server and giving it the same name. Add volumes with the same name as the
volumes on your original server. Bring the server on-line and install the appropriate
TSAs (see the Installation Guide).

3. Recreate your auto login user assigning the user the same name and password as on
your original installation server.

4. In Resource Manager, tag the volumes on your failed server.

TIP: In  Resource  Manager,  to  tag  all  of  resources  on  the  same  target,
highlight one of the resources from that machine and press the “/” key to tag
all of the resources for that machine.

5. Open the Operations menu and select Restore/Full Resource.

6. Insert the media as requested. This will restore the data on all tagged volumes on
your original server to the new server.



Moving a Backup Director Installation

This  section  details  procedures  for  moving  a  Backup  Director  installation  from  one
server/volume to another.  

Assumptions

• The Backup Director installation directory name has been created on
the target server and is identical to the directory name on the source server. 
• The auto login user exists on the target server with the same password
and appropriate rights as the auto login user on the source server.
• The  target  server/volume  supports  the  same  name  spaces  as  the
source server/volume.

Procedures

Reconfigure the Installation

Before copying the installation files, you need to update the System Control Database and
Enterprise Setup so it will represent the new installation.

TIP: To save your original database files prior to updating them, copy or
rename the *.PAC files in your installation directory.

1. Open Configuration Manager.

2. Open Configure/Enterprise Setup. Delete the current installation and the job queue
(select Delete Physical Queue).

3. If appropriate, type in a installation description name in the installation name field.

Installing On a New Server

If you are not moving your Backup Director installation to a new server, proceed to “Copy
Software” below. If you are moving your Backup Director installation to a new server, follow
the steps below.

1. Open Configuration Manager. If using a new auto login user, add the user in the auto
login name and password fields. If moving from a 3.x server to a 4.x server, use the
NDS auto login name and password fields.

2. In the Admin list tab, remove any obsolete administrators/operators..

3. Add any new administrators/operators from the new installation server.

4. In the User list tab, remove any obsolete users and groups.

To install hardware on a new server

1. Install the SCSI Host Adapter and backup device on your target server.

2. Load the appropriate SCSI drivers on your server.



3. Copy  SCSISCAN.NLM  from  the  \TOOLS  directory  on  the  last  Backup  Director
installation diskette to the SYS:\SYSTEM directory on your target server.

4. After  the  hardware  is  set  up  and  the  proper  drivers  loaded,  type  the  following
command at the server console:

LOAD SCSISCAN 

SCSISCAN scans the SCSI bus and displays all SCSI devices. If the backup device is
not displayed, this indicates that there is a hardware issue that needs to be resolved.
See the Installation Guide for more details on installing the backup device and SCSI
host adapter.

Copying Software

1. Create the Backup Director directory on the target volume using the DOS MKDIR
command.

2. Copy  the  Backup  Director  installation  and  its  subdirectories  from  the  source
server/volume to the target/server using a command similar to the following:

XCOPY FS1\VOL1:\PAL\*.*   FS2\VOL1:\PAL   /S 

(where  FS1  is  your  source  server,  FS2  is  your  target  server,  and  PAL  is  your
installation directory.  The /S parameter copies all subdirectories.)

NOTE:You must keep the same path for your System Control Database. For
example, if your original installation directory was \PAL you must move it to a \
PAL directory.

3. Copy all  Backup Director NLMs and appropriate TSAs to  the target server's  SYS:\
SYSTEM  directory.  If  you  are  not  moving  your  Backup  Director  installation  to  a
different server, you probably do not have to perform this step (by default the NLMs
are copied to the SYS:\SYSTEM directory).

4. From the source server's SYS:\SYSTEM directory, copy the following files to the target
server:

AR*.RSF, PAL*.NLM, PALSTART.NCF, TSAxxx.NLM+, SMDR.NLM, WSMAN.NLM
+substitute the appropriate TSA for your server.

Unload NLMs

If you moved your Backup Director installation to a new server, skip to “Preparing the New
Server” below.

If you moved your Backup Director installation to a different volume on the same server you
must:

• Unload the job server (PALJSRVR.NLM) and PALMEDIA.NLM
• Delete the job queue
• Reload the job server and specify the proper path.



To unload PALJSRVR and PALMEDIA

> At the server console prompt, type:

UNLOAD PALJSRVR

UNLOAD PALMEDIA

If you haven't already, delete the job queue on the installation server.

> Open Configuration Manager and select Configure/Enterprise Setup.

> Delete  the  current  installation  and  the  job  queue  (select  Delete
Physical Queue).

To reload the job server and PALMEDIA

1. At the server console prompt, type:

LOAD PALJSRVR /I<<installation path>>

where <<installation path>> is  the  volume and directory  that  you copied
your installation directory to (for example, VOL1:\PAL). 

2. At the server console prompt, type:

LOAD PALMEDIA

Continue to Installation Configuration below.

Preparing the New Server

1. If you have configured a new auto login user for the new installation, create the user
on the server or in the NDS tree.

2. Load the appropriate TSA's on the target server. Refer to the Installation Guide if you
are unsure of which TSA's need to be loaded.

3. At the server console prompt of your target server, type:

LOAD PALJSRVR /I<<installation path>>

where  <<installation  path>>  is  the  volume  and  directory  that  you  copied  your
installation directory to (for example, VOL1:\PAL). 

4. At the server console prompt, type:

LOAD PALMEDIA

Installation Configuration

Be sure to login as an administrator prior to running Backup Director.



To configure the installation

After successfully loading the job server and PALMEDIA:

1. Change  the  properties  of  your  Backup  Director  icon  so  that  the  command  line
specifies the  new installation location.  If  end users  use  File  Manager,  be  sure  to
inform them of the new location of PALFILER.EXE.

2. Open Configuration manager. Open Configure/Enterprise Setup.

3. Choose Insert.

4. Select the installation server and the installation. (The path for your new installation
should display in the installation text box.) Choose OK.

5. If necessary, add any administrators/operators to the Admin List and users to the
User List.

Configuring File History Database Location

NOTE:This  section  should  be  completed  only  if  the  Backup  Director's
databases are centralized.

Each resource on the protected resource list must have the File History Database location
updated to reflect their new location.

1. Access Resource Manager.  Highlight  a resource that your  original  installation was
protecting.

2. Open the Operations menu and select Edit Resource Info.

3. Select Change File History Database Location.

4. A pick list appears listing the target servers. Choose the target server, then select the
target volume that you moved your Backup Director installation to.

You should receive a message indicating that the File History Database already exists
for the resource. Choose Use Existing Histories.

5. Repeat steps 1 through 4 for the rest of the resources on the Protected Resource List.
The History path for each resource should identify the new target server.

6. After updating your resource's history database location, update the default location
for  your  centralized  databases.  Choose  Operations/File  History  Database.  Select
Configure and  select  the  default  server  volume  on  which  to  store  your  history
database(s).

Configure Backup Device

If the host adapter number or SCSI ID on the backup device has changed from the original
setup,  then  the  backup  device  may  need to  be  re-configured.  To  do  so,  access  Device
Manager, choose Operations/Scan for Devices, then choose Devices. You may need to delete
the current device and re-scan the bus to find the new host adapter number and/or SCSI ID.



Consolidating Volumes  

Consolidating volumes is the process of combining two or more volumes. It is usually the
result of adding a new, larger volume to replace existing volumes.

To consolidate volumes using Backup Director, you should

> Perform a Full Backup operation on the source volume(s).

> Tag  the  source  volume  in  Resource  Manager,  open  the  Operations
menu and select Restore/Full Resource. Select the Redirect to option.

> Select the target volume. 

To perform a full backup

Prior to consolidating volumes, be sure have a snapshot of the volume(s) as it exists prior to
redirecting its data to a new volume. 

> In Resource Manager, tag the volumes being consolidated.

> Open the Operations menu. Select Backup/Full. 

To copy data from one volume to another

1. In Resource Manager, tag one volume that you want to consolidate. 

2. Open the Operations menu and select Restore/Data.

3. In the restore dialog box, select Redirect to.

4. Choose the Server,  Target Service,  TSA,  and Resource to restore the data to and
choose OK.

This operation will restore all directories, files, and trustees from your source volume
to the target volume. 

5. Perform the steps above for each volume you want to consolidate.

6. When you have successfully consolidated the volumes to a single volume, perform a
full backup on the volume so that all data is copied to backup media and so that the
File History Database reflects the new volume configuration.

7. If you no longer will be using the volumes you are consolidating (VOL1 and VOL2 in
the above example), delete them from the Protected Resource List or make them
inactive (see chapter 8 for more information).

File History Databases

When consolidating volumes, you must decide which File History Database you want to use
for the new volume or create a new File History Database for the new volume. 



Your original File History Databases will not be redirected when performing the procedures
above.

If there is a specific File History Database you want to use for your new volume, you should
restore it  to the new volume (note that you cannot merge File History Databases and a
volume can have only one File History Database).

To redirect a File History Database

1. In Resource Manager, tag the source volume.

2. Open the Operations menu and select Restore/File History Database.

3. On the restore dialog box, select Redirect to.

4. Choose the Server,  Target Service,  TSA,  and Resource to redirect  the File  History
Database to and choose OK.

Note that, unless distributing File History Databases, the File History Database is not
actually moved to the target volume but it moves to the target volume's File History
Database location.

File Server/Volume Cloning 

Cloning is  the process of  making an exact  duplicate of  an existing volume or  an entire
server. When cloning a volume, the new volume includes the directory/file structure of the
original volume and retains the original volume's File History Database.

Why Clone?

Why would you use Backup Director to clone a volume and/or file server? Why not just place
the file server on the network and copy the directory/files to the new volume? 

Cloning a volume involves more than just reconstructing the directory/file structure. In the
case of a NetWare volume, there may be user privilege restrictions attached to directories
that are just as important to duplicate as the directory/file structure.

For a NetWare 3.x file server to be cloned, the Bindery must also be duplicated. Without the
help of Backup Director, this process involves multiple steps and can be very complicated.

When  performing  a  cloning  operation,  if  the  file  server  and  all  the  volume  names  are
identical, you can run the same operation as you would for a full server restore.

Full Backup

Before cloning a volume or server you will want to be sure all files are copied to a single
media set. The best method is to perform a full backup on each volume you are cloning.

Cloning a Server

The following is a summary of the steps required to perform a cloning operation.



> Perform a full backup on the source volume(s) to be cloned.

> In Resource Manager, tag the volume to be cloned.

> Open the Operations menu. Select Restore/Full Resource.

> On the restore options dialog box, select Redirect to.

> Choose the Server, Target Service, TSA, and Resource to redirect data
to and choose OK.

Assumptions

The following procedure assumes the following for your new server:
• The target volumes have identical names to the source volumes
• You  have  installed  and  loaded  the  appropriate  TSAs  on  the  target
server and added that server to the Protected Resource List

NOTE: If  cloning volumes on a 3.x server to another server, you must also
redirect  the Bindery resource so the trustees and Object IDs for  users not
defined on the target server will not have to be recreated.

Procedure

1. If your new server is a NetWare 3.x server, recreate your auto login user with the
same name and password.

2. In Resource Manager, tag the volume(s) you are cloning. Open the Operations menu
and select Full Backup. This ensures you have a snapshot of your volumes on a single
media or media set.

3. After the backup is complete, tag one of the volumes you are cloning. If  you are
cloning a 3.x server, you should tag the Bindery resource as your first resource to
clone and then the SYS: volume.

4. Open the Operations menu and select Restore/Full Resource. 

5. On the restore options dialog box, select Redirect to.

6. Choose the Server, Target Service, TSA, and Resource to redirect data to and choose
OK.

7. Repeat the above procedures for each volume you are cloning.

NOTE: If  you  are  cloning  a  Backup  Director  installation  server,  follow  the
instructions  in  Moving  a  Backup  Director  Installation for  instructions  on
loading the appropriate NLMs and other setup information.

___________________________


